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���������������������� 

�	
��	�
���	��� !�"�����"#�$	�	
���%��#�&
������"���%'�"#�"
�	
��
�	(����	� *������ + ,-'
�
�	#�&
������,-'�����	
 ./'��-������	
��%���%&
,-'� 0	��	�,-'�
�	��1	�������
%'���%�            
�,�	
�&
 (������ 4.34) 
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������������!"��#��
������� 
���"#�$	�	
�3$����	����	�$�6���78����#�&
��������	�#�&
�
�����
(�� ���������	�"
������ 

4.35 � 9
�	
3$��$�6���78����#�&
������������	
�	��
 : �.<.2545 
�����
���#�&
������������	

�	��
 : �.<.2551 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
������ 4.35  ���� 
�����
�	��	�3$��$�6���78���	�#�&
������ 
 
�������$%����%������
������� 

��
����������'��������#�&
������� 9
�
�	��	�,-'3$��
	�����-�����'��������#�&
������,-'(��
��
,/�(����%'���	���	����	"�"��������"#� (������ 4.36) 3���-$��
����2�"
�	
3$���� (��3�� 

1. ��	�
�?!���,-'"#�3$���� ��%'�"#���
%'���%� Label 
2. ��	�
���	 Tolerance $�	�
����
%'���%� 
3. ��	�
�$-3$�����������#���%&
,-'�����%�� (Selection Color) �
�
�	��1	� 
 

 
 
 
 
 
 
 
 
 
 
������ 4.36  �
�	��	���
����������'��������#�&
������ 
 

�������	
��
������� 

������������	
��
������  
����������	��� 
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��������
�������������	��������$��&! 
�
8-,-'������3��E	
������(�����,�	�	
	��

�	���	���	��	
	���%'�"�����"#���%���#%'��

�	
	�,-'�����	
���	���#�&
�������#���%&
,-' 
��1, Feature class �#�
 
Feature class   ��������'�&%	�# 
1. ��������	��  ��������	�� 
2. ��������	��   ������ 
�#	�
"
��	�� 
�	
�#%'��#�&
�������
�'��	���%��#�&
������,-'�����	
�#%'���	
	� *��������	$���	
��	�%� 

3�����%����
� ‘�#%'��#�&
���������	����	
	�$����
��’ �� 
	�G�
�	��	�,�	�	
��������� 4.37 ./'�"

�
�	��	�
-&��3$���	
	�������,-'$	�	
��#%'�����	$�� Feature class �	�
�&
���"#�$	�	
���%���	
	�
,-'�����	
"#��#%'�����	$�� Feature class $�	�
����
�"#��	
������	�
-&�- 
�*�#
�"
�
8-,-'���"#������	

3$���������

�	���	�"

� 3���
	? ��&
��
"
�	
�#%'��#�&
���������	����	
	�$����
���-���
-& 

1.  ��%��
� 3���	
�#%'��*���	
	���� Feature class ./'��-�	
�#%'��*�� 2 
� 3�� �%� 
*  ��%��������,�&����,-' Feature class �-: �	
��%�� 
��1,
-&"#�"
�
8-,-'���"#�"����	�

$
"���������� Feature class � 9
���� ���
�&
�	���	
�
������"
�	
	�,-'
�	�	
�#%'���-(���
����"
Feature class ������������3$����	����	� 9
 NULL 

*  ��%���J�	�������,-'�
���� Feature class �-: "
�
8-
-&* 
3�
�����%��������"

�	
	�,-'�
���� Feature class �,�	
�&
 �#�
 ��������� Feature class �- 100 �

��
�� 3����%'�
�	�	�#%'������	
	�3����-�������
���
��-�� 50 �
��
�� ��%'��#%'��
������3��� * 
3�
���3$������������	(����-�� 50 �
��
�� 

2.  �����	���%��
� 3���	
�#%'��*�� ���"#���%���	
	�������,-'���#%'��*�����	��� Feature 
class �	������	
 3���������	
�#%'��*��*���	
 Uncheck ,2�M �	
	� (�	
�#%'��
��������"#��
�����	���	�����
%'�����'��/&
) 

 
�	��
����������������� 
��
�
-&"#���#�&
������,-'(�������	
"#�����	��
�	��	�#�&
������"#��	
 
 

 
 
 
 
 
 
 
 
 
 
 
 
������ 4.37  ���� 
�����
�	��	��#%'��#�&
���������	����	
	�$����
�� 
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4.10 ���*���������	�"����+�������,���� 
��
%'���%�$�	�
���	
����	
������,-'3$���������
�
�	��	�3�
,-' � 9
��
%'���%�$�	�
����
�	

�������
%�����	
�	
3$��������������
�
�	�� �	
� !���
��
�	��	�3�
,-' ,�	(��*��������	$�
��	
��	,-'�
�	��	�3�
,-' �� 
	�G��
���������� 4.38 ����P
��	��
�#���,�	�	
�
�
�	��	�3$��
3�
,-'�- 14 ��
� ./'��-�
�	,-'�	
,�	�	
��	�M ���
-& 

* 
��2#�&
������,-'�����	
��%��  * ��
�	�	��	
	��

�	���	� 
* ��
�	�	��������#���%&
,-'  * ��
�	�	��	
	���	�$����
�� 
* 3$�����	
$%���
   * 3$�����	
$%���
��P���1	� 
* ��	���%'�
(��	
��
�	   * ��	�
���,	���
�	 
* ��	��������
	?!��
�
�	��  * � �-'�
#%'�#�&
������ 
* 3$��������� 9
�
	?   * 3$��3�
,-'"��� 
* 3$��1	�,�&����   * �	
	�$
2 ������ 

 

 
������ 4.38  ��
�#���,�	�	
�
�
�	��	�3�
,-' 
 
��	
��
���������������������� 

��
�
-&"#�$�	�
���	
��	�
���	��� !�"�����"#�$	�	
���%��#�&
������"���%'�"#�"
�	
��
�	(����	� 
�-�
�	��	��	
,�	�	
��������� 4.32 
-��"�/����������'�&%	�# 

��
�
-&"#�$�	�
��$%���
�	��������

�	���	�,-'�J�	���	������#�&
�������#���%&
,-',-'�����	
 
*���
�	��	��	
,�	�	
���%�
�����
�$%���
������"
������ 4.28 ���,-'���	��	3��� ./'���������	

$%���
�� 
	�G"

� 3��3�
,-' 
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-��"�/����������%�$�
���� 

�	
��
�	�	��������#���%&
,-'� 9
�	
��
�	,-'�	<����	�$����
���#����	3�
���������2 �#�
 
�	�
���,	� �	��	
�	������	
�
%�����"�����-����
 *��"#���	�$	�	
��#���%&
,-'���* 
3�
�"

�	
$%���
 ./'��-
� 3������	
��
�	,�&���� 8  
��1, �%� 

* $�'�,-'��%��������� 0	��	� (Intersect) 
* �
��$-'���-'���	������	
 (Envelope intersects) 
* $�'�,-'��%��.��
,��� 0	��	� (Overlap) 
* $�'�,-'��%���	���	
� 0	��	� (Crosses) 
* $�'�,-'��%������1	�"
� 0	��	� (Within) 
* $�'�,-'��%���
����2�� 0	��	�,�&���� (Contain) 
* $�'�,-'��%������"������� 0	��	� (Near) 
* $�'�,-'��%���-�2�<�
����	�1	�"
 (Have their center in) 
 

 
 
 
 
 
 
 
 
 
 
 
 
������ 4.39  �
�	��	���
�	�������#���%&
,-' 
 
$�	�
���
�	��	��	
��
�	3$����������� 4.39 3���-��	����	
,�	�	
���
-& 

1.  ��%��#�&
������ (Polygon, Line, Point) ��%'�"#���
�	�#���%&
,-'"
#�&
�������%'
*��"
������ 
1.36 (��"#�#�&
�������

� 9
#�&
��������
�	 *��(����%���

 
��1,�%&
�

3�P�3��
"#�(��,2�\���	�"
��	�1���%���	]$�
�2� �����	
��
�	�	��	
	��

�	���	� 

2.  ����P
��	 #�&
������,-'(����%��(��"
��&
��
,-' 1  
	�G"
�
�	��	�$��
,-'        ./'�� 9

�
�	��	�3$��������	�#�&
������,-'��%��(�� 

3. 
��2
� 3���	
��
�	3��
���,	��
%�����������	
��
�	 "
,-'
-&"#� “$�'�,-'��%�����
���� 0	��	� (Intersect)” ��	���	���	 ,�	�	
��
�	������	
,-'����"

�<�- 500 ���

����

 
��1,�%&
�

3�P�3��"#�(��,2�\���	�"
��	�1���%���	]$�
�2� 

2 

4 

1 23

4

5
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4.  $��
,-'          "
������ 4.39 � 9
�
	?!�,-'3$��"����P
��	 
� 3���	
��
�	,-'��%��*��
#�&
��������
�	"
��&
��
,-' 3 $	�	
�"#����#�&
������ 
��1,"���	� (Polygon, Line, 
Point) 

5.  ��%��#�&
������� 0	��	�,-'�����	
��
�	*���	
���� + �
�	#�&
������ 3������ 
6.  ������	���������	
��
�	�	���&
��
��	���
��(����������� 4.40 ./'�(��
��2"���-�	
��	�

��������
�	 3��"
������ 4.41 � 9
������	��	
��
�	,-'(��(����	������� 

������ 4.40  � 0	��	�,-'�-�%&
,-'�
����2�#�&
������������	
��
�	 

������ 4.41  ������	��	
��
�	,-'(��(����	������� 
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-��"�/�������-:�����$��&! 

�	
��
�	�	��������

�	���	� (Attribute) � 9
�	
��
�	�	�������,-'�-�	�
������#�&

�������,�	
�&
 3��"
�
8-,-'#�&
������������	��-�	
	�$����
�� (Relate Tables) �#%'������./'��	
��
�	
�������	��	
	�$����
��������	�
-&����"#�
� 3��,-'3����	����( ���������	�"
������ 4.42 *���-
��&
��
�	
,�	�	
���
-& 

1.  ��%��#�&
������$�	�
���	
��
�	./'������ 9
#�&
������,-'�-�	
	�$����
���#%'����� ������	�
"
������ 4.42 ��%��#�&
������,-'��&�*
��
-�
: ��	�1���%���	]$�
�2� 

2.  *��#�&
�������-�	
	��#%'����� �� 
	�G
	�#%'��	
	�"
$��
,-'        ./'����"#�$	�	
�
��%����
�	�������	��	
	�,-'�����	
 "
,-'
-&(����%���	
	�,-'��&�*
��
-�
 

3.  ��%'���%��#%'��	
	�,-'�����	
��
�	3��� �� 
	�G#%'�?!���"
$��
,-'       ��%'�"�����"#���%��
��	����
�	�������	�?!���"� ("
������	�(����%��?!��� 
��1,*
��
-�
) 

4.  ��%'����"#���%��?!���,-'�����	
��
�	 * 
3�
���3$��������,-'�-����"
E	
���������?!���
,-'��%������	 ��%'�"�����"#���%����	�����	
��
�	�������	���	"� ���-�	
��%����	,-'��
��
�	,�	(��*�� ������������
������ �
%�����,-' 2d���%��
	��	
 ��%'�$����	( ���$��
,-'        
"
��&
��
���(  "
������	�
-&� 9
�	
��
�	*
��
-�

���������</�7	 

5.  ��	�
�
� 3���	
��
�	*��"#���
%'����	� Like �	�
�&
����� *�	#-�*������7
�

�
�	���� 
	�G� 9
$-3�� �� 2d� Enter �
3 0
�������%'��%
��
�	
3��(������� 
$�	�
���	
$%���
���� SQL �-���"#��	
�#�
��-������	
$%���
�	��	
	��

�	���	� 

6.  ����                       ��������� 
	�G��������� 4.43 
7.  3$�����	
$%���
� 9
�	
	������� *������                                   ��(��

���������������� 4.44 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
������ 4.42  ������	��	
��
�	�������	��	
	���	�$����
�� 
 
 

2 

3

5 

1
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������ 4.43  *
��
-�

���������</�7	 �
�
�	��,-'(���	��	
��
�	�	��	
	���	�$����
�� 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
������ 4.44  ���	
��
�	�	��	
	���	�$����
��"

� 3���	
	����'����� 
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����,������	-�� 
���	
$%���
������
���	�������"

� 3���	
��%���%&
,-'�
�
�	��3��� ���"#��	��
-��

3$�����������'�����"

� 3���	
	� (������ 4.44) �	
3$�����	
$%���
�	��	
	� �- 2 3�� �%� 
® ����������������;:���
�"�� ���-��	����	
��%����������� 4.44 "
�
�	��	�
-&���"#�$	�	
���%��

��
,/�������,-'(���	��	
��
�	� 9
(?�� 
��1, Excel (��*������   
® ��������*�����		�'%�% � 9
�	
3$��������,-'��
�	(��"

� 3��$���� ./'�"#�(�����#�&
������

,-'�-�������������,�	
�&
 ��	,	�$����,-'3$����(���%� ��	$��$2� ��	�'�	$2� ��	�J�-'� ��	
��-'����
�	�
E	
 ��
�� 3����
�������	�����
 

 
����,������	-����<�/�=�$ 

"
�	��
�&��	
3$�����	
$%���
�
%��	
��	�/���1	� �-��,�	"�������P
������,-'�����%��
(���
� ��
%'���%�
-&��#���"�������P
������,-'�����%���
�,�&����  
����������;����-��"� 

���"#�$	�	
�,�	�	
��	���%'�
(��	
��
�	��%'����������	
��%���%&
,-',�&����,-' 
	�G�����

�
�	�����,2�#�&
������ 
������#����-��"� 

�
8-�	
��
�	�#���%&
,-' ���"#�$	�	
���	��������	
��
�	 (Buffer) ./'��-��,�	"����	
������,-'��	����( �������	 ���
�&
��%'��	
��	�
�
�	
$%���
�$
P�3��� �/���	� 9
������	�
��������
�	,-'��	�(�����(   
�������������>?�	�"���/� 

�������
	?!�� 9
������,-'��	������
�
�	��./'�(���-��	���	�"�M � 9
$�'�,-'�����/&
�����	�
,�	�	
$%���
������
%'���%� "#���	���������
�	�	���	3�
��$����� *��"#�$�6���78��2�$-3�� �2�
������	�
-&$	�	
���	�����	��
�	��(��*��"#���
���	��������
	?!��
�
�	��  
�����#�������
������� 

�
%'���	�
���� !�*��	$"�����"#�$	�	
�
�	#�&
��������-����
���	( 3$�����
�
�	��(��
��	��
�&� �	��
�&��	�,�	"��������	�$��$
 ��
�� �-'�
#%'�#�&
��������#���"�����"#�$	�	
���&�#%'�#�&

������(��"��� (������ 4.45) 

 
 
 
 
 

 
 
 
������ 4.45 �
�	��	�$�	�
��� �-'�
#%'�#�&
������ 
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������������@����> 
��
�3$��������� 9
�
	?"#�$�	�
��3 ��#�&
������,-'�����P������� 
��1����������	3$����"


� 3������
	? (�
	?3,�� �
	?����� �
%��
	?$��$��
) ./'��-��&
��
�	
,�	�	
���
-& (������ 
4.46) 

1.  ��%��#�&
������ 
2.  ��%��
� 3���
	?,-'�����	
3$���� 
3.  ��%��?!���,-'�����	
3$���
	? �	�
	�#%'�?!���"
$��
,-'        ./'������ 9
?!���������

 
��1,��	
�
������ ?!���,-'�����%�������$��(  
	�G"
�	
	���	
��	�%� 
4.  ��%��$-�	� Color Ramps ��%'���	�
�$-"�����������3����?!��� 
5.  ��	�
��
	�3��
� 3������
	? 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
������ 4.46  ������	��	
3$����������"

� 3���
	?����� 
 
�����,����*"�+ 

��
�3$��3�
,-'"���"#�$�	�
���	
 Refresh �
�	��"��� �
%'���	�"
�	��
�&��
�	��3$��
3�
,-'�	����-�	
3$����,-'(���
����
�
%�(���������,�&���� 
 
����=�$��
�"�� 

"
�	��
�&����"#��	����-�	
��	�1	��
%����1	� �
(��$	�	
������P
1	�
�����3�
,-'
,�&����(�� �	��������$-����	����
%���	�3�
,-'"��� ��
�3$��1	�,�&������#���"����P
1	�
��
,�&�������3�
,-' (������ 4.47) 
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������ 4.47  ������	�1	������	�"#���
�3$��3�
,-',�&���� 
 
�������
������� 

��
��	
	�$
2 ������"#�"
�	
,�	$
2 ������
�����
��� Feature class �#�
 "
�
8-,-'
�����	
,
	���	1	�"
��	���
/'�M �-��2��#2���
"���	�3����2��#2���
3����#2�,-' 
	�G�-�
	��%&
,-'
�,�	(
 ��������� 4.48 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
������ 4.48  ������	��	
"#��	
��
��	
	�$
2 ������ 
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4.11 ���$%�$!�,���� 
�����	�,-'���"#�,�	�	
��%���%&
,-'� 0	��	�3���-�	

�	��	#�&
��������	�M �	3$��
�����


3��� ���"#�$	�	
���	�
�
� 3���	
�����3�
,-'*������     ��%'����	$���
�	��	�,�	�	
��	�
�

� 3��3�
,-'3��
	�����-���%'
M (��3�� �	�
	$��
 $�6���78�,�<��
%� ��	����	�$�6���78�3�

,-' � 9
��
 �
�	��	��	
�����3�
,-'�-���� 
����������������� 4.49 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
������ 4.49  ���� 
��������
�	��	���	�
�
� 3���	
����� 
 
�-���������+��A ���*��*��������		���$%�$! 

��
%'���%�"#��	
��%'����3��3����	�
�
� 3���	
������-��������� 4.50 
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�
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11.    � 9
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,-' �-��	����	
$
�	�������( 
-& 

1.  ��	�
��
���%&
,-'$�	�
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2.  ��%��3�� ��
������� 
3.  ��%��#�&
������,-'�����	
3$��$�6���78�./'�����"
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 Map Layer 
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������� 9
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#��� Legend Title 
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9.  ��%��3�� �B�"��-+���������! (������ 4.60) 
10.  0�
��	����	
��	�
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	���� 5 

��������C���������B�"��	���*�����D������ ����. 

 

5.1 ��������C���������B�"��	���*�����D������ ����. 
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2.  �	
 Identity #�&
��������	�M ������������	�� 
3.  �	
$
�	�
� 3���	
3$��������$�	�
�� 
$,� (Style) 
4.  �	
$
�	�E	
������$	
$
�,<$�	�
�� 
$,� (Geodatabase) 
5.  �	

�	���������	$��* 
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5.2  ������	��
�������������/������������	�
����� 
 
1.1  �����?�D������ ArcMap 
1.  � !�* 
3�
� ArcMap *�� ��%�� Start > Programs > ArcGIS > ArcMap �
%� ����,-'(���


 �
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2.  ��%�� A new empty map 3����� OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
�
�	��	�* 
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���$�	�
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"#��	
 
 
1.2  ���������������:#D������ ArcMap 

1.  ,-' Menu ��%�� File > Add Data  �
%�����,-' 2d�  
2.  ��%�� shape (?��,-'�����	
���'�������  
3.  ��%�� Add 
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1.3  �����	
��		$%�����%��B��"�+� (XY Coordinate System) 
1.  � !�* 
3�
� ArcCatalog *����%�� start > Programs > ArcGIS > ArcCatalog 
2.  ��%�� Connect to Folder �	�3����
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3.  ��%�� Folder ,-'��P� Shapefile (�� 3����� OK 
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�
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��2
��������"��#�&
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������	,-' Shapefile #%'� 

tambon 3�����%�� properties  
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5.  �
�	��	��28$��������(?��3$�����
�  ( ,-'3�� XY Coordinate System 3����� Select 
6.  ��%�� Project Coordinate Systems ��%'���%��
��������,-'�����	
 
7.  ��%�� UTM 
8.  ��%�� WGS 1984 
9.  ��%�� WGS 1984 UTM Zone 48N.prj 3����� Add 
10.  ��%'������	,-'�
�	��	�������(�������
� 3����� OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
,�	�
���
�	
��-����

-&��� Shapefile ,-'#%'� province 3�� amphoe 3��#�&
�������%'
M ,-'

����"#��	
 ��%'��$
P�$�&
"
��&
��

-&��,�	"��,2�#�&
�������-
��������,-'��������
���$�	�
���	
,�	�	
"

��&
��
���(  
 
 

5
6

7

8

9

10 



69�
�

�

1.4  �������� Field �B�"��	��<	��������:# Add Field *� ArcMap 
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1.  � !�* 
3�
� ArcMap ,�	�	
 Add Data ��%'���%��3$��#�&
������,-'�����	
  
2.  ������	,-' tambon ��%�� Open Attribute Table ��%'�,�	�	
� !��	
	�����	����#�&
��������	�� 
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	�����	������	��3$������	 
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3.  �	��	
	� ��%'������	
���'������
�"����%�� Options > Add Field ��%'�,�	�	
���'������
�"
#%'�
�	�,-'�����	
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.  "
#��� Name ��	�
�#%'������
�,-'�����	
, Type ��	�
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��1,���������,-'��P�"
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��%'� Add Field $�	�
P�3��� 
Field ,-'��	� 9
������	�
�$�	�
���������	
 ��
��"

������	�M ��%'�"#�"
 
$,� �-���
-&  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

tambon: 
1. Name = PrvCode, Type = Text, Data = Length 2 
2. Name = ProvinceNa, Type = Text, Data = Length 25 
3. Name = AmpCode, Type = Text, Data = Length 4 
4. Name = AmphoeName, Type = Text, Data = Length 50 
5. Name = AdmCode, Type = Text, Data = Length 6 
6. Name = TambonName, Type = Text, Data = Length 50 
7. Name = AdminName, Type = Text, Data = Length 200 
8. Name = DataSource, Type = Text, Data = Length 200 
amphoe: 
1. Name = PrvCode, Type = Text, Data = Length 2 
2. Name = ProvinceNa, Type = Text, Data = Length 25 
3. Name = AmpCode, Type = Text, Data = Length 4 
4. Name = AmphoeName, Type = Text, Data = Length 50 
5. Name = AdminName, Type = Text, Data = Length 200 
6. Name = DataSource, Type = Text, Data = Length 200 
province: 
1. Name = PrvCode, Type = Text, Data = Length 2 
2. Name = ProvinceNa, Type = Text, Data = Length 25 
3. Name = AdminName, Type = Text, Data = Length 200 
4. Name = DataSource, Type = Text, Data = Length 200 
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1.5  ����$%����#�����#�*� Field ��������*"�+D�#*�� ArcMap 
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1.  �������	,-' Field ,-'�����	

�	�������	"$�("
,-'
-&�%� PrvCode) ��%�� Field Calculator 
2.  �� Yes ��%'���	�
�
�	
��� 
3.  ��%�� Fields ,-'�����	
��	���� *���	
����$���
�&� 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.  ��%'�#%'� Field  
	�G"
�
�	��	���	
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�  "���� OK ������"
 Field ,-'��	���������
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 Field ,-'�
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1.6  ����	 Field D�#*�� ArcMap 
1.  "
�	
	����#�&
������ "��������	,-' Field ,-'�����	
�� 3�����%�� Delete Field  
2.  �� OK ��%'��%
��
�	
�� 
 
 
 
 
 
 
 
 
 
 
 
 
Field ,-'(�������	
����� 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.  �	�
�&
"���� Field ,-'(�������	
,�&�"����� ("
,-'
-& Field ,-'�����	
��(��3�� FID, Shape 3��,2�

���,-'(�������	
) 
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����� tambom, amphoe, province �����������B�"��	 ���� ����B���	 �����
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5.3  :%&� Identity ��:#��	����B�	� 
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3$������������* 
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����
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M ��� #�&
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��,	� GIS ,-'
��������	�"#�(��3���	

��2
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���'�����
	��	
3$������-�����

��$��	�� #%'���	�� 
��$��	�1� #%'���	�1� 
��$������� 3��#%'�������� "�����#�&
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��������	
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3��
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1.  "
3����
�"������,-'  ��%'�"��* 
3�
��������
%'���%� (Tools box)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  "
����� Analysis Tools ,�	�	
��-'�����%'��	��	$�'� Identity 
3.  ����$���
�&�  
4.  �
�	��	���
%'���%��� 
	�G�/&
 
 
 
 
 
 
 
 
 
 
 
 

��*$%����� (1) Input Features  
#���������	
��
�*����%��')�	�*)	���	
�

�����"��*�%�/�#��� ���
��
�
#���������	
��	
�"�%� 

��*$%����� (2) Identity Features 
#���������	
��
�������%��')�	���	
�
��� Input ���
��
�#�� ��"��*
*$%"� 

��*$%����� (3) Output Features 
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3��� ��%'�� 9
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$
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5.4  ������������		������������� (Style): ArcMap 
 
"
* 
3�
� 
$,� �-$��
 
����,-'$�	��6���	��	�"
�	
3$�������� �
-����	 Style ./'����,�	

�������-��	���	� 9
����,�	�	
$
�	� Style ���#�&
���������
,-'�����	$���
���
�	

�	���	#�&
������"

* 
3�
� 
$,� *���-��&
��
���
-& 
1.  � !�* 
3�
� ArcMap 3��� Add data �%� Village_Identity.shp �	�
�&
� !��	
	�����	����

��������%'�,�	�	
���'� Filed ��������� (������	� �	
,�	style �����������	3�
�����������	
) 
2.  ,�	�	
���'������
�*�� Add Field 3�����	�
�#%'���	 Style 3�� Type � 9
������7
 (Text) �
	�

��	����	���������
��,�	��� 50  
3.  ��%'�(�� Filed ,-'#%'���	 “Style” "
�	
	�
	�����-�������� ,�	�	
"$�
	�����-�����������"
�����
� 

“��	3�
��������	
”  
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4. �	�
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,�	�	
$
�	�
� 3���	
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������  3����%��3$�� 
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�	��	������
%'���%��	
��	�
����78�  
1.  Symbology 
2.  ��%��,-' Categories > Unique Values  
3.  �	�
�&
"
#��� Value Field "����%�� Style  ./'�� 9
 Filed ,-'$
�	���&
���
�
�	$�	�
���	
��	�
� 

Style *���J�	�  
4.  ��%�� Add all Values ��%'�"����	��� Filed  
	�G  
5.  3�������$���
�&�,-'$�6���78����
	�����-�������� 
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�3��� ��&
��
���( � 9
��&
��
����	

�	
� 3��
������	�( "#��	
"
* 
3�
� 
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1.  3����
%'���%� ��%�� Tools > Styles > Export Maps Style  
2.  * 
3�
���"����	�
�,-'���� 3����&�#%'� Style ,-'$�����(  
3.  �� Save 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.  �����������	
$����� Style ��%'�
��	
"#��	
  
	�G���1	� *��(?��,-'(���-
	�$�2�  .Style 
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5.5  ��������C���������������E (Geodatabase) 
 
Geodatabase � 9

� 3�����E	
������,-'��P�
��
��������,	� GIS ./'�� 9
������,-'

 
����������	�
� 3�������� (��3�� 
� ���-'�� !� (Polygon) �$�
 (Line) �2� (Point) �	
	�������
����	� (Table) 3���������#���
�� (Raster) ./'��-��	�3����	���
���	��	� 3�����	�(
�P�	�
E	
������ Geodatabase $	�	
���	
����	�$����"
�	
�����P���%'�"#�"
�	
����
	���
�����
(��
*����	� ���-�	
$
�	� Geodatabase �-��&
��
���
-& 
 
4.1  ��� ����� Personal Geodatabase 
1.  � !� ArcCatalog �/&
�	3�����%�� Catalog ( ,-' Folder $�	�
����P� Shapefile ,-'�����	
"#��	
 
 
 
 
 
 
 
 
 
 
 
 
2.  ( ,-' Menu ��	
�
��%�� File > New > Personal Geodatabase 
3.  (�� New Personal Geodatabase ���
�  
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4.  � �-'�
#%'� Personal Geodatabase �	� 
��1,���������,-'��	�
� "
,-'
-&"��� 9
 
AdminBoundary 
5.  Click ��	,-' AdminBoundary ��%�� New > Feature Dataset 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.  ��	�
� Name � 9
 BaseMap  
7.  3����� Next 
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�	��	�"����	�
�
����������� Feature dataset (�����	
�P�#�
��-������	

��2

����������� Shape file "
��&
��
���
�
�	
-&) $	�	
�,�	(�� 2 ���- �%� 
 
:%&���� 1 
1.1  ��%��
��������,-'�����	
 *���	
��%�� Projected Coordinate Systems  
1.2  ��%�� UTM > WGS 1984 > WGS 1984 UTM Zone 48N �	���	��� 3����� Next  
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:%&���� 2 

��2*��"#�
����������� Shape file ,-'(��,�	�	

��2( 3���"
��&
��
3
�  
1.  ,-'�
�	��	� ��%�� Import 
2.  ��%�� shape ,-'�-�	

��2
��������( 3��� �#�
 tambon.shp 3����� Add 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
"
��&
��

-&(�� Feature dataset ,-'�-
��������
��2� 9
 WGS84 UTM Zone48N �
-��
���3��� 
3.  �� Next  
	�G�
�	��	����1	� "���� Next 
4.  �� Finish 
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��%'�(�� Feature Dataset 3��� "
��&
��
���( � 9
�	
$
�	� Feature Class $�	�
��#�&
������ 
 

1.  Click ��	,-' feature dataset #%'� BaseMap ,-'$
�	��/&
���
�
�	 ��%�� New > Feature Class 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  *������
��������������
������� “��	���/��":��” "
#��� Name ��	�
�� 9
 ProvinceBoundary 

3�� Alias (#%'� ��� �
%�#%'�,-'�����	
3$��) � 9
 ��	���/��":�� 3�� Type � 9
 Polygon 
Features ���1	� 

3.  �� Next �� 
	�G�
�	��	���%'�"��"$�����������	
	��

�	���	�  
4.  ("
,-'
-&����"#��	
	���� province .shp) "����%��*����,-' 2d� Import 
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5.  ��%��(?�� 
 
 
 
 
 
 
 
 
 
 
 
 
(��*�
�$
�	����E	
������,-'�-�	
	�,-'�
�����������
��,-'��%���	"#�  
 
6.  �� Finish ��%'�$�&
$2�"
�	
$
�	� Feature Class ��%'�
��	
*���������"
��&
��
���(  ./'�*���
�

����������A �<�B���:#���	:�������#:��� 
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4.2  ���D"����
������� 
��%'�$
�	�,�&� Geodatabase , Feature Dataset 3�� Feature Class �$
P�3��� "
��&
��
���( 

���	$����&
��
����	
*�����������%'�$
�	�� 9
#�&
������,-'�����	
 (�
8-,�	  Feature class “ 
ProvinceBoundary”) 
 
1.  ( ,-' Feature Class ,-'�����	
 ������	,-'��%'�,�	�	
*��������� 
2.  ��%��������,-'�����	
*���"
#��� input data 
3.  ��%�������� 
4.  �� Add 3����P Next 
5.  �� Next �-��
�&� 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1

2

3

4

5



91�
�

�

6.  �	�� 9
#�&
������,-'�-*�
�$
�	�������,-'���%�
��
��
 
�'
�%��-#%'���� field ,-'���%�
��
 * 
3�
���
,�	�	
 Match field *�����*
���� �
%����,�	������$	�	
���%�� Field (���	������	
 ��%'��
-��
���
3����� Next 

7.  ��%�� load all of the source data ��%'�*���������,2����	�"
#�&
������*��(���-��������
 
8.  ��%�� Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

��%'�����&
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-&��(��������"

� 3�� Geodatabase ,-'�
���"
�	

�	���	$��* 
3�
� 
$,� ./'�
"
�
8-���#�&
�������%'
M �P������	
�
���
�	
,�	�������-��-����

-& 
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5.6  ����B�������������+D������ ���� 
 
#�&
������������	
,-'����"

� 3�� Geodatabase 3���- Style $�	�
���	
3$����"
 
$,� �	�

��&
��
���
�
�	 $	�	
�
�	���	$��* 
3�
�(��*���-��&
��
���
-& 
 

1.  � !�* 
3�
� 
$,� 3�����%���
�(���
 
�	���	������ ���1	� 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.  "
�
�	��	��	
����	
#�&
���������* 
3�
� ,�	�	
���'���2��#�&
������ *���	
����    
3.  ��&�#%'���2����������	 ��������	�����#���%&
,-'  
4.  ��%'��$
P��
-��
����� 
	�G��
%'���%�"�����'�#�&
������ ,�	�	
��%����2��������,-'�����	
���'� 3���

��%�����'�������  
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5.  ,-'��
�3����#�&
������ "
#���#%'�#�&
������ "����	�
�� 9
 ��	3�
��������	
 ��%��E	
������ 
Geodatabase ,-'$
�	�(�� 3����%�� Feature Class ,-'#%'���	 Village ��%�� Field Value � 9
 
VILL_NAME 3�����%�� ���(   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.  �
�3�� �#%'�������������� ��%'�,�	�	
�#%'�����* 
3�
�"��$	�	
��
-��"#�(���	�?!���������

�������
-& ������������� �#%'������ 
��$������� ��������	�1� �#%'����� 
��$��	�1� 3����	��
�#%'�����
��$��	�� ���1	� �����(  
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7.  "
3�� �	
	����'�����"
�
8-,-'(���-�	
	����������'����� "������%�� ���(  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3����
%'���%� ��	�
�$-������ � 9
�	
�
-��"#� Style ,-'(��$
�	�(��"
��
���
�
�	 *�� 
1.  ��%��(?��  
2.  ./'�� 9
�	
��%��(?�� Style ,-'$
�	�(��3��� �	�
�&
������%�� Marker Symbol  
3.  ��	�
�?!���������� 9
 Style  
4.  � 9
?!���,-'$
�	��	��%'�"��� 9
 Style �	�
�&
,�	�	
�,-�������� 
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2
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